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PURPOSE:

The purpose of this manual is to describe the data in the CIGIS, where it came from, and what has
been done to integrate it into the system. The Appendices serve as a store of further technical detail
about the GIS.

CHRISTMAS ISLAND GRID 1985 PROJECTION (CIG85):

Data within the CIGIS is in the CIG85 projection.  CIG85 is a plane rectangular grid coordinate
system with True Origin coinciding with a point at UTM GRID ZONE 48 coordinates 570 000mE
and 8 840 000mN (WGS 72). At that point the false origin is 20 000mW and 60 000mS of True
Origin

DATA:
Data in the CIGIS are organised in a tree structure, under the
directory "cigis". Files are kept in sub-directories named according
to the subject area, usually relating to the supplier of the data (and
perhaps the type),

eg. the directory "auslg25k" contains the 1:25000 scale data
supplied by AUSLIG.

The source files as used are stored in a ‘source’ subdirectory to
each of the subject area directories.  This allows for the checking
of veracity with regard to what was originally supplied.  The detail
of the conversion methods applied to the data by MREB are
presented in Appendix 1.

On the following pages is a description of the data contained in
each of the subject area subdirectories of directory “cigis”.  For
many of the datasets a quick plot of the data is included with the
description.

Fig 1: Data tree structure
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‘ANCA’ Directory

Abbott’s Booby Bird Data

Description

Abbott’s Booby Bird sites on Christmas Island are displayed as point data in the GIS. There are
6272 points. The source of this data was a dBase file from the ANCA PC on Christmas Island (file
‘history.dbf’ dated 11/11/1992). The shapefile’s table contains all fields and data (essentially
unmodified) of the original dBase file (see Table 1). The spatial coordinates of the original file were
based on a line and peg grid, probably using the bulldozed lines of an old mining grid.
Transformation was based on Autocad® Release 7 maps also existent on the PC.

Accuracy

Since these data points (projected to Christmas Island Grid 1985) plot similarly to those in the map
abbsite.dwg, used in the transformation, it is likely the errors are similar.  The lines in this map do
not appear to be accurately surveyed (note displacement of the line/peg coverage with regard to
orthophotographs).

Data Source

The original data was retrieved from a hard drive on the ANCA PC in the Abbott's Booby Bird
Office on Christmas Island. Almost all raw data was in a local line and peg grid based on one of the
island's mine grids, and was not referenced to a known projection. However, the disk did contain a
number of maps created in Autocad® Release 7. Some of these had been rotated into a Universal
Transverse Mercator (UTM, Zone 48) map projection (though in different units). Using these it was
possible to derive a shift to Christmas Island Grid 1985( CIG85).

In addition to the Autocad® maps, a dBase® file (history.dbf) was retrieved from the PC. This
contains abundant data for each Abbott’s Booby Bird site. Contact ANCA for an explanation of
these attributes. Spatial reference in this database was line and peg coordinates (as described above)
and, thus, could be projected to Christmas Island Grid using the shift derived using the Autocad®
maps.

Conversion by Mineral Resources and Energy Branch

Detail of the process by which the Autocad® map files were converted into the CIGIS is presented
in appendix 1 of the manual.
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Fig. 2 Abbott’s Booby Bird sites

Table 1. Fields in history.dbf (with an example site)

SITENUMBER 0412
GROUP 20
BLOCK 001
REGYN X
POST89

A200 Y
OTHERBLK 000000000

STATUS 0000000000000000131202020202020101 1
MOVES 000000000

PMOVES 00000000000000000000000000000000000000005704000000000000000000000000
CLRDIS 12
PAST A
LINE 153.83
PEG 136.00

RISKCLR RH
FSTYR
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Line/Peg Grid

Description
This line and peg grid was used by ANCA in its Abbott’s Booby Bird surveys. The source of this
data was an AutoCad map (abbsite.dwg) on ANCA’s Christmas Island PC. The grid probably in
reality runs along the bulldozed lines of an earlier mining grid (visible on the orthophotographs), but
does not plot there when overlaid on the orthophotography.

Accuracy
The error in the data appears to be in the vicinity of 100 metres. As clearing boundaries and coast
(though highly simplified) of the same map plot in far better position (after transformation) in
relation to the orthophotographs and other GIS themes, the majority of inaccuracy in this theme is
probably inherited from the original map (abbsite.dwg). That is, it appears that the clearings and
coast of abbsite.dwg are reasonably accurate though very imprecise (intended to be viewed at much
greater scale), while the line and peg grid appears less accurate. Thus the grid on the GIS is mainly
illustrative at this time. It is also notable that, since Abbott’s Booby Bird sites from the more recent
history.dbf plot beyond this grid, the grid has probably been extended. It may well be that a more
accurate version exists. MREB could undertake a correction to this data if common points with the
orthophotography can be identified by ANCA.

Fig. 3. Line/Peg grid used in collection of Abbott’s Booby data.
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Field Rehabilitation Surveys

Description

After 1985, in preparation for rehabilitation of some previously mined areas, ANCA commissioned
ground surveys of those areas. Three of these, Fields 20s and 22a, and Field 19a (illustrated below),
are included in the GIS. Fields 20s and 22a were provided in CIG85, while Field 19a, the most
recently completed, is probably in Christmas Island Grid 1992 (CIG92).

Accuracy

The Mineral Resources and Energy Branch does not know the accuracies or precision of this data.
MREB are not yet aware of a simple conversion between CIG85 and CIG92 and vice versa, so a trial
rectification of Field 19a to plot in its true position in the GIS has not been undertaken.
Since the GIS provides Digital Elevation Models (DEMs) and contours of the island, this sort of
survey would be largely unnecessary in future.

Fig. 4. Survey of Field 19a prior to rehabilitation.
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ANCA ‘Old Maps’ subdirectory

Description

This directory contains two scanned images (geology.tif and veg.tif) which were obtained as
dyelines from ANCA, scanned then registered and rectified for inclusion with the GIS.

The geology map contains the following information:
Base map compiled from topographic base sheets prepared by Australian Aerial Mapping Pty. Ltd. and
supplied by The British Phosphate Commissioners.

Geology and compilation by J. Barrie 1965-66
Drawn by J. Kopros

Bureau of Mineral Resources, Geology and Geophysics
CHRISTMAS ISLAND SURVEY 1965-66

To accompany Record 1967/37.

The vegetation map contains the following message:
Vegetation map -
Accompanies Mitchell’s
   1985 Report. ONLY COPY!!
See File 80/13 for Report.

It is based on J Barrie’s geology map.

Accuracy

Registration of the geology map was accomplished using a formula derived empirically on the
island, extended for conversion from Imperial Island Grid (lines visible on scan) to CIG85. As the
vegetation map did not contain visible grid lines, the formula could not be used, so registration was
dependant on scarce and imprecise common points between the vegetation map and the AUSLIG
1:25000 data in the GIS.

Errors in the location of these scanned maps result from:
1. Error due to original intended accuracy and scale (1:25000). This could result in errors of

up to 25 metres.
2. Error introduced in the scanning process (probably minimal)
3. Error introduced in registration. This will be significant in the vegetation map, but is

probably minimal in the geology map.
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Fig. 5. Selections from J. Barrie’s 1965-66 geology map (scanned)
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Fig. 6. Selections from vegetation map accompanying Mitchell’s 1985 report.
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‘Auslg25k’ directory

Description

This directory contains 1:25000 scale topographic data originating from the Australian Surveying
and Land Information Group, Department of Administrative Services, Canberra, ACT, Australia
(AUSLIG). Topographic data has been reproduced with permission of the General Manager,
AUSLIG. The data covers the whole island, and includes polygons, lines and points describing both
natural and built environment.

The AUSLIG data includes the following 1:25000 layers :
•  roads,
•  10 metre contours,
•  spot heights,
•  buildings and other structures,
•  hydrology,
•  boundaries for the national park,
•  boundaries for the mining leases and
•  boundaries for four vegetation types.

The 1995 release of the AUSLIG digital data for Christmas Island was published at the 1:25000
scale.  For this release the existing 1988 map was updated.  The data was provided in Arc/Info
format in the Christmas Island Grid projection.  Only ‘feature coded’ data was available as AUSLIG
do not see there being many sales of this dataset.  Feature coded data are the lowest level of release
for Arc/Info data by AUSLIG.  There was basically no documentation with the data - only a list of
feature codes and their frequency.  MRB have had to re-work the data into its present form.

The AUSLIG data are subject to copyright and MREB hold a licence. The cost was $300.  Licence /
royalty arrangement pro forma were submitted by MREB for Territories Office and PRL in January
1996.  Maps produced and distributed beyond the licensee that include the AUSLIG data are
required to carry the following acknowledgment (contact at AUSLIG is Ian Miller 2014311):-

Topographic data reproduced with permission of the General Manager, Australian Surveying and Land
Information Group, Department of Administrative Services, Canberra, ACT.

Accuracy

Publication at the 1:25000 scale has important implications for the use of the AUSLIG topographic
data.  Some of the plots MREB have produced include enlargements to scales of 1:2000.  This
means the AUSLIG data are being displayed at over ten times its published scale.  Users should
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view AUSLIG lines on such enlargements as representing a line around ten times as thick, the true
line occurring somewhere within that much thicker line.  It is far more expensive to capture data at
small scales.

As the data was originally intended to be used at 1:25000 scale, zooming in past this will show
visible offset from the orthophotographs, potentially by as much as 25 metres. On zooming, the
orthophotography will be more accurate, having error of at most 6 metres. A special case is the
mining lease boundaries, which is superseded by the CIA mining lease data. The AUSLIG mining
lease data should not be used. This superseded data is stored in the “defunct” subdirectory. It is
provide to assist with verification and cross comparison with other mining lease boundary
information users may acquire.

Data source

The original data was obtained as two Arc/Info export files (xmas.e00 and xmasrel.e00), containing
general data and contour/spot-height data respectively. Considerable work was necessary to make
this useful for the GIS.

Manipulation of Data

A series of Arc/Info macros similar to those applied to the CIA data were used to strip out different
feature classes and build them as separate point, line or polygon coverages as appropriate. In
generating polygon coverages cleaning was required. To suit use in Surpac mining software a
version of the contours as polygons was created.

‘Auslg25k’ national park boundaries

The AUSLIG 1:25000 scale national park boundaries were found to be of insufficient accuracy for a
number of requirements of the CIGIS.   This data subset has been moved to the ‘defunct’
subdirectory and should not be used.  The value of keeping this data in the system is to help
eliminate any spurious national park boundary data sets that may turn up from other sources over the
years.

The best set of national park boundaries MREB could locate are stored in the ‘CIA’ directory.
These were obtained from Auslig Perth as part of the 1987 cadastre data set and are accurate to
1:1000 scale.
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Fig. 7. Cliffs, Streams, Pools and National Park (1:25000 data)

Fig. 8. Vegetation of Christmas Island (1:25000 data)
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Fig. 9. Built Environment (1:25000 data, north-east region)

Fig. 10. Ten metre contours (1:25000 data)
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Fig. 11. Spot height data points (1:25000 data)
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‘CIA’ directory

Description

The CIA directory contains data belonging to Christmas Island Administration and obtained from
AUSLIG (Western Region). This data is 1:1000 scale data and only covers the north-east portion of
the island. It contains essentially the same features as the AUSLIG 1:25000 data but more precisely
located.

Accuracy

This data should be correct to about 1 metre. For most of the north east portion of the Island this
data and the orthophotography have a very good correlation   usually well  under one metre in
difference. Around tall buildings and cliffs there may be a discrepancies between the data and the
orthophotographs. This is a factor of aerial photography angles and interpretation and in these cases
the 1:1000 vectors should be more reliable than the orthophotography.

In the western most extremity of the data set the accuracy has been called into question by the
orthophotography contractor. They observed, after checking the orthophotography against results
from analytical stereo plotters, that “it appears that in the vicinity of the market garden, the mapping
data supplied... may be in error by approximately 5 m in  east”.

The data was provided as six Arc/Info export files which are stored on the core data CD in the
directory ‘cigis/cia/source’:

Manipulation of Data

Detail of manipulation of the data for use in CIGIS is presented in Appendix 1. Separate data themes
were split out of the provided export files via Arc/Info routines. In Appendix 1 there is an example
and description of the Arc/Info macro series that were used to do this.

Addition of 1:1000 Scale National Park Data

The national park boundaries in this directory cover the whole of Christmas Island and are the best
MREB could obtain. They originate from AUSLIG Perth as part of the 1987 cadastre data set and
are accurate to 1:1000 scale. The cadastral data did not include internal boundaries of the park. Thus
it was necessary for MREB to add the mining lease boundaries (supplied as part of the cadastral
data) to the data national park boundaries to create the full national park boundaries. This process is
explained in more detail in Appendix 1.
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Fig. 12. Point infrastructure of north-east region (1:1000 data)

Fig. 13. Line Infrastructure of north-east region (1:1000 data, detail of phosphate
loading area, Flying Fish Cove)



Christmas Island Geographic Information System (CIGIS) Phase 2

14/08/00 3:51 A8/P8    g:\cigis\ci_working\manual\sysdoclr.doc System Documentation 19

Fig. 14. Vegetation of north-east region (1:1000 data, detail of Poon Saan Area with
roads added for reference)
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Fig. 15. One metre contours of north-east region (1:1000 data)

Fig. 16. Spot heights for north-east region (1:1000 data)
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Fig. 17. Mining leases (1:1000 data; as at September 1987)
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‘Demtiles’ directory

Demtiles (a concatenation of “DEM tiles”) contains some samples of a representation of the Digital
Elevation Model as TIFF images.  The DEM has had a shiny colour drape algorithm applied in
ERMapper® which has then been reduced to 256 colours to minimise storage on disk. Tiles over
disturbed areas have a one metre cell size, those over primary rainforest have a five metre cell size.
There is one 4 kilometres by 4 kilometres tile number 2469 for the north eastern quarter of the
Island, with the rest being 2 km x 2 km except for some partial tiles along the coast.  The colour
range for each individual tile has been optimised so as to give a maximum of information a
consequence of this is that  colours may not match at adjoining edges. Further TIFF images like
these can be prepared on a cost recovered basis.

Fig. 18. Digital Elevation Model key plan
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DEM contours

A useful spin off of the digital orthophotography is the opportunity to get one metre contours over
the disturbed areas of the Island.  For the north-east area of the Island 2km X 2km DEM contour
tiles have been trialed in the CIGIS.  Most are at a contour interval of 5 metres but tiles 2269 and
2469 have been done at a one metre contour interval.

The DEM contours are surface contours.  They pick up the reflective surface beneath the aircraft.
The reflective surface may be the ground or it may be a dense vegetation canopy or rooftops etc.
Further one metre contour coverage can be prepared on a cost recovered basis.

Fig. 19. DEM contours coverage
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‘DOLA’ directory

Survey Control Data

Description
The DOLA survey control shapefile is based on GESMAR AGD84 data supplied by the Department
of Land Administration (DOLA), Western Australia. It contains 260 surveyed points, with UTM,
WGS84 (latitude and longitude), CIG92 and CIG85 coordinates. Many points also have attributed
height data.

Accuracy
The accuracy of each DOLA point is contained as attributes of the shapefile (method, order and
accuracy in both horizontal and vertical).

Manipulation by MREB
The format of the data has been extensively manipulated by MREB (see Appendix 1). MREB has
added CIG85 coordinates from survey control data obtained from Auslig, Perth in paper published
form which has been OCR scanned and matched by MREB. These CIG85 values were then used to
display the points in ArcView as an event theme prior to conversion to a shapefile.

Fig. 20. Survey control points (DOLA)
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‘Orthphto’ directory

The orthphto (abbreviated “orthophotography”) directory is where the orthophotography resides on
the hard disk. On most systems not all the orthophotography will be in this directory, due to
limitations of disk size.  Most orthophotography of disturbed areas (mining or township) is on the
“core” CD-ROM and the “mining enhanced” CD-ROM. As a general rule the orthophotography is
accurate to between 0.3 metres and 0.5 metres in the north east area of the Island. For other
disturbed areas of the Island the accuracy ranges from 0.5 metres to 4 metres depending largely on
the proximity of, and enclosure by, the aerial photography survey control points (‘PP points’).
Worst accuracy is in the distant and more inaccessible areas of primary rainforest and these
accuracies range from 4 metres to 6 metres with the south west point being an area of lowest
accuracy. Also in the orthphto directory are the digitised outer boundaries of some pinnacle fields.

Fig. 21. Orthophotography tile key plan
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Fig. 22. A 1km X 1km orthophotography tile
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‘PRL’ directory

In Situ Resources Phosphate Stockpile Data

Description

This set of in situ and stockpile outlines are those prepared for the ‘Appraisal of Phosphate
Resources on Christmas Island’ Stage 1 report produces by BRS for Territories Office in May 1995.

Accuracy

Prepared as a general guide at the 1;25000 scale. Progressively being superseded by work being
undertaken by MREB for Territories Office and PRL.

Manipulation of Data

The outlines for stockpiles and insitu resources held in the ‘PRL’ directory, files ‘stkpiles.shp’ and
‘insitu.shp’, were prepared as follows:

•  The outlines of stockpiles and insitu resources were originally prepared by Phosphate Mining
Corp of Christmas Island (PMCCI) on plans at scales of 1 inch = 1000 feet (1:12000); and 1 inch
= 2000 feet (1:24000). It is not known how these outlines were located but PMCCI may have
drawn the boundaries from controlled aerial photographs. The base maps were prepared by
Australian Aerial Mapping Pty Ltd in 1965.

 

•  Mackay and Schnellmann Pty Ltd (John Garlick) reduced these plans to 1:25000 and traced the
outlines onto a 1:25000 base plan of the Island showing mining leases. Garlick deleted those
stockpiles which had been mined (recovered) by PMCCI and PRNL.

 

•  In preparing maps for the Stage 1 report, MRB traced Mackay and Schnellmann outlines onto an
AUSLIG base map showing the surveyed outlines of the lease boundaries. The lease boundaries
for ML132  and the boundaries of the 4 stockpiles on this lease were surveyed (theodolite) by
Russel Payne (McKimmie Jamieson & Partners) and compiled on a plan at 1: 2000 scale. The
boundaries of these 4 stockpiles were transferred to MREB’s plan by reducing the scale to
1:25000.

 
•  The final maps were then drawn electronically by Cartographic Services Unit of the Australian

Geological Survey Organisation.
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•  For stockpiles, the weight in kilotonnes, the P2O5 grade and the R2O3 (=Al2O3+Fe2O3) content
have been included in the coverage where available to allow queries against these attributes in the
GIS.

The following Figures have been removed from the distributed version of the Christmas Island
System Documentation as requested by Phosphate Resources Limited
Fig. 23. In situ phosphate resources
Fig. 24. Phosphate stockpiles (supplied by PRL)
Fig. 26. Phosphate stockpiles (digitised from old mining maps)
Fig. 28. Phosphate stockpiles (digitised from aerial photography)
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‘Old_Maps’ subdirectory

C-Series Maps

Fig. 25. ‘C’ series map key plan.

Description

The C-Series maps are old mining maps commissioned by the Phosphate Mining Corporation of
Christmas Island (PMCCI). The original maps are in miles and at a scale of 1:4800. These have been
scanned, clipped, registered and rectified for inclusion in the Christmas Island Geographic
Information System as transparent overlays. Included with the system are those containing mining
information as per Figure 25 above:

C-5,
C-7, C-9, C-10,
C-12, C-13, C-14, C-15,

C-18, C-19,
C-24.
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Stockpile boundaries digitised from old maps

Description

The stockpile outlines from the C-Series maps were digitised by the Cartographic Services Unit
(CSU) of the Australian Geological Survey Organisation (AGSO). These outlines were supplied in
Imperial Island Grid (IIG) coordinates, and transformed into Christmas Island Grid 1985 (CIG85)
coordinates. They were built as polygons in ArcInfo®. Being in vector form means that they have
far more functionality in ArcView®. They are able to have attributes added (for example, stockpile
identification) and are able to be queried (both spatially and by attribute).

Accuracy

It is noted that the raster (image) stockpile outlines do not exactly plot in the same place as the
vector outlines. Although the same formula was used for registration of the image as was used for
transformation of the vectors, the following differed:  The image data was supplied as scans with no
coordinate information. Registration thus was accomplished using the labelled IIG grid vertices
present on the maps as a starting coordinate, whereas the vector data was supplied in IIG
coordinates, so the transformation was accomplished using tics which already had IIG coordinates.

Maps M3, M4 and M5

Fig. 27. Maps 3, 4 and 5 key plan
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Description

Maps 65-XIA/M3, 65-XIA/M4 and 65-XIA/M5 (Maps M3, M4 and M5; see Fig 27) are 1:12000
scale maps originating from PMCCI. We have called them:

•  ‘m3n12kr4.tif’ (map3, northern region, 1:12K, rectified group 4 tiff),

•  ‘m4s12kr4.tif’ (map4, southern region, 1:12K, rectified group 4 tiff), and

•  ‘m5w12kr4.tif’ (map5, western region,  1:12K, rectified group 4 tiff), respectively.

The original copies were supplied by Peter Barrett in April 1996.  These maps represent the situation
with phosphate resources on the Island prior to the change of ownership in the mid 1980’s.  They
have been scanned and registered in the same way as the C-Series maps and are available in the
CIGIS as transparent overlays.

Stockpile boundaries digitised from the orthophotography

Description
BRS has digitised the footprint of stockpiles that could be detected from the 1987 aerial
photography. Stockpile boundaries were interpreted from stereo viewing of this aerial photography
with reference to the ‘C’-Series maps (see above). Boundaries so defined were digitised on screen
directly onto the CIGIS orthophotograph of the area. The final result from this stereo viewing and
digitising is a total of 229 stockpiles.

Accuracy Comments
The accuracy is as yet undetermined but is expected to vary between 1:1000 and 1:10,000 scale for
individual stockpiles with accuracies nearer to 1:1000 being more likely. The 1987 aerial
photography from which the stockpile boundaries were derived, is nominally at the 1:10,000 scale.
The accuracy of the orthophotography obviously underpins the digitised stockpile boundaries.
Digitising onto the orthophotography was done on a 17” monitor with the resolution set to 800 by
600 pixels.  An individual stockpile could be zoomed to fill most of the screen at the time of
digitising.  This could approach the legibility limits of the orthophotography at around 1:500 scale.
On-going use, cross comparison with other layers in the CIGIS, and field checks will, over time, not
only better indicate the accuracy of this layer but also allow for incremental improvement of
boundaries.  Where tall vegetation obscures the side slope of the stockpile, difficultly with
interpreting the foot of the slope can result in a poorer accuracy.
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Diagram 1. Integration of Surpac mining engineering software with the CIGIS
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 ‘Sitepics’ directory

The Sitepics (abbreviated “site pictures”) directory contains 56 scanned pictures (as TIFF images)
from various sources (mostly Mineral Resources and Energy Branch photographs, some PRL and
tourist brochure photographs). The images include historical pictures, diagrams, photographs of
mining, mined areas and mining equipment, photographs of rehabilitation, and some scenic pictures.
Most are referenced by a hotlink to the theme ‘sitepics.shp’ (clicking on the marker, geographically
positioned, with the hotlink tool pops up the image). In a number of instances the geographic
positioning of the photographs is a guess or illustrative (eg the photograph of a truck being filled by
a front end loader). MREB welcome your feedback on the true site from where such photographs
were taken so they can be more accurate positioned.

Fig. 29. Site photographs (‘sitepics’) hotlink theme
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‘Tileplan’ directory

Tileplan contains a variety of coverages used by Mineral Resources and Energy Branch, Bureau of
Resource Sciences, for decision-making and checking concerning the image tiles currently on the
system. It also contains some coverages that are used by the GIS where they were developed by
MREB and relate to the layout and location of orthophotography, digital elevation model (DEM)
and contour (derived from the DEM) tiles.

Survey control (PP points)

Description

This dataset contains a variety of survey control points, many of which (especially the PP points)
were used in the triangulation for the CIGIS orthophotography. They were obtained from copies of
AUSLIG survey field books, photo-control point sketches and a coordinate listing of photo control
points (copies of all items are on BRS file No. 96-001757).

Accuracy

The Bureau of Resource Sciences does not have all accuracy data relating to these photo control
points. The station summary sheets for PSM114 (PP9), PSM102 (PP17) quote orders of accuracy for
easting and northing as “2” and the orders of accuracy for R.L. as “4”. In addition, PSM1 (PP24) and
PSM3 (PP25), which do not have surveyed height, agree with orders of accuracy for easting and
northing of “2”. It is likely, then, that the other PP points have the same accuracy. Further
information should be obtained from AUSLIG.

Acquisition

The data was originally in field notebooks, photo-control point sketches and coordinate listings,
copies of which were obtained from AUSLIG.

To convert it to digital form, the coordinate listings were OCR scanned. The OCR output was then
imported into Microsoft® Excel, corrected and saved as a comma-delimited text file. The table was
then added to an ArcView® project, and made into an event theme. Finally, for consistency and
portability, the event theme was converted to a shapefile.

The attributes of the data in its final form are “Point Number”, “Description”, “Easting”, ”Northing”
and “Height”. Eastings and northings are in CIG85. Height is in metres. A column labelled “PP
points” has been added by MREB and contains an abbreviation of the station description coupled
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with a flag as to whether the station has been height-surveyed. This has been used to divide the
ArcView® legend, and relates to usefulness for the preparation of the orthophotography.

Fig. 30. Aerial photography survey control points (PP points)
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Aerial photography plan data

The Mineral Resources and Energy Branch created several new datasets for analysis and planning
with regard to the orthophotography and DEMs.

Approximate flight lines and aerial photograph centres
These were digitised from the aerial photography flight line diagram. Digitising was on-screen based
on a hard copy map as polylines and points respectively. They are only intended to be approximate
and have proven adequate for our purposes.

Aerial photograph circles
This theme consists of circles as approximations of aerial photograph extent. This is a useful way to
depict aerial photographs as the centre of the photograph is truer. The circles were derived from the
aerial photograph centres already described. Ungenerate in Arc/Info obtained an ASCII file, a radius
field was added to this file using UNIX’s vi editor, and Generate Circles (in Arc/Info) created a
circles coverage. The radius was chosen by measuring the dimensions of a scanned and registered
aerial photograph.

Fig. 31. Aerial photographs chosen for scanning
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Stereo-pair models

Stereo-pair models were derived from the aerial photograph representative circles by an intersection
in Arc/Info. Figure 31. below shows a reduced set designed to determine which models were
necessary for higher resolution (1 metre) DEMs.

Fig. 32. Stereo pair models necessary for higher resolution DEMs
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SYSTEM:

Hardware

Suitable hardware consists of a pentium processor, a CD-ROM drive, at least 16Mb of RAM, at
least a 1Gb hard disk, and a display resolution of at least 640X480X256 colours.  However, display
of 800X600X32K colours or better is recommended.  The government price (similar to tax exempt)
at the time of writing for recommended hardware is $2,985 for the PC plus $1,304 for a 17” screen.
PRL opted for an IBM PC.  IBM PCs come with 3 years of 24 hour, 7 day/week hotline support for
the price of a local call.  Detail of current IBM government prices is :-

Recommended configuration :
Pentium 133Mhz (std 16Mb RAM, 1.2Gb HD) $2,279.00
Hard disk upgrade from 1.2Gb to 2.1Gb $409.00
RAM upgrade from 16Mb to 24Mb $115.00
Video RAM upgrade from 1Mb to 2Mb $82.00
CD-ROM drive - Sony quad speed IDE $100.00
17” Sony trinitron screen $1,304.00
Recommended configuration total $4,289.00

Options :
RAM upgrade from 24Mb to 32Mb $107.00
Screen upgrade from 17” to 20” Sony trinitron $1,461.00

An advantage of having a larger hard disk is that less staff time is lost to swapping orthophotographs
on and off the hard disk. The Christmas Island GIS is currently running successfully on a variety of
PCs including IBM, Compaq, Osborne, Canon portable and Terran. It is advisable not to enable the
advanced windows features of 32 bit disk or file access.

Software

The Christmas Island GIS has been established in ArcView software.  ArcView runs on PCs, Macs
and UNIX.  The layers and CD-ROMs we provide are portable between all three platforms.  The
cost of an ArcView licence for a PC is about $1,800.00.   The Christmas Island GIS is currently
running successfully under a variety of operating system combinations including:  PC Dos 6.30 with
Windows 3.11; MS-Dos 6.22 with Windows for Workgroups 3.11; Sun UNIX; and Windows 95.
There are also be MapInfo compatible format layer files (‘.mid’ and ‘.mif’) on the core data CD-
ROM.
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Added functionality

Creating a user-defined graticule

Graticule tool

Associated Avenue Script: View.CIGGraticule

Copyright: R. Gallagher
This script is not for distribution to other organisations beyond the CIGIS licensee.

Function: Creates a metres graticule as a graphic over a user-defined region. Clicking and dragging
to define an area in a view returns a dialogue box. The user enters the distance between graticule
lines and the number of divisions between the lines (defined by crosses; this may be equal to zero).

The script checks for user confirmation if a large number of graphics will be drawn (when drawing
the graphics will take a long time).

Double clicking allows for a graticule larger than the screen to be drawn via a map extents entry
window.

The plus symbol need be present in the default ArcView palette. This can be achieved by loading
cartography palette that ships with ArcView.

Checking orthophotograph, DEM and DEM contour tile numbers

Tile information tool

Associated Avenue script(s): View.TileInfo

Function: Returns the identifying numbers for orthophotograph tiles, DEM tiles and DEM contour
tiles, based on a user click in the view.



Christmas Island Geographic Information System (CIGIS) Phase 2

14/08/00 3:51 A8/P8    g:\cigis\ci_working\manual\sysdoclr.doc System Documentation 48

Shapefile editing functions

Significant editing functionality is now available from the inclusion in default.apr of the additional
functions of the ArcView sample editing interface, avedit.apr (in as-supplied form in the
\win32app\arcview\etc directory).  Following is the ESRI description of this functionality:

Version 1.0

This sample interface extends ArcView's editing capabilities through new controls and scripts created using
Avenue. These include:

Vertex Add Tool - You can add new vertices to the selected line or polygon by drawing an intersecting line
with the mouse. A new vertex is created wherever a feature is crossed.

Vertex Delete Tool - You can delete vertices from the selected line or polygon by drawing a box around the
ones you wish to delete.

Reshape Tool - Reshape all selected lines or polygons by drawing an intersecting line. The new line will
replace the existing lines between the first and last intersections, and will be used to reshape all currently
selected features.

Split Tool - You can split the selected line or polygon by drawing an intersecting line. All attributes from the
original feature will be copied in the new features created by the split.

Transaction Management - Use the Edit menu to Undo or Redo changes you have made. Edit transactions
are stored and can be undone in sequence. You can Redo the previous Undo, except feature splits. Note that
moving of features or vertices does not create a transaction.

In addition to single step Undo and Redo, the entire Edit Transaction List may be undone, or cleared. A
message will be posted when the transaction list exceeds 100 transactions.

The Edit Transaction Manager can be enabled or disabled. A system bell can be toggled to indicate when
transactions are stored. By default the Edit Transaction Manager and the transaction bell are enabled
whenever you start editing.

Known Limitations:

(1) Vertex editing, reshaping, and splitting of multi-part features (e.g. regions, polygons with 'holes', routes)
is not supported at this release.

(2) Reshaping around the origin of polygons will always preserve the part which contains the origin. If this is
not desired, use Split, then delete the unwanted part.

(3) An Undo of a split transaction can not be Redone,

(4) Undo and Redo use stored transactions. Moving a feature or vertex does not create a transaction.

PLEASE NOTE: The editing interface and the associated scripts are not supported by ESRI.

MREB Note: This editing interface will probably not be updated by ESRI as the functionality has
been incorporated into ArcView 3.0.
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Setting the data location

Interface: Project window; File menu, “Set Data Location...”
      Returns a dialogue box for user input.

Associated Avenue script: Project.SetEnvVar

Function: Sets the value of the variable $CIGIS, which is referenced in many scripts and in the
original projects supplied by the Bureau of Resource Sciences (BRS). This variable describes the
location of the Christmas Island Geographic Information System (in most cases equal to c:\cigis).

The script checks whether the directory entered exists and returns a warning if it does not.

Use: This variable is set automatically in the startup script, as modified by BRS. The menu item
described here is a fall-back in case the startup script fails to set $cigis. Exiting ArcView unsets the
variable.

Calculating dimensional information for a theme

Interface:  Dimension button, or
      View window [theme(s) must be active]; Theme menu; “Calculate Dimensions”

Associated Avenue script: View.CalculateAreaPerimLength

Function: Calculates the area and perimeter for the entities of a polygon shapefile or the length for
lines, and adds the results as new attributes of the shapefile or updates the existing dimension fields.
If updating, the script prompts the user for confirmation.

Use: Works on the selected theme(s). Select a theme or themes and select the menu item.

Setting the display properties of a theme

Interface: View window [theme(s) must be active]; Theme menu; “Set Display Scale...”
      Returns a dialogue box for user input.

Associated Avenue script: View.SetThresholds

Function: Sets the maximum and minimum scales at which to display the theme(s). This function is
already present under Display in the Theme Properties dialogue box, but must be done individually
for each theme. Using Theme Set Display Scale all selected themes are set. This is useful where
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many themes are to be set to the same display scales (for example the orthophotographs in the
CIGIS). The defaults are a minimum scale of 1:1 and a maximum scale equal to the current View
scale. A scale of ‘1:0’ is tested for and not allowed (with a warning displayed)

Use: The user selects themes for which the same display properties are required. Selecting Theme
Set Display Scale brings up a dialogue box in which to specify maximum and minimum scales. Note
that as in the Theme Properties dialogue box, setting a maximum scale of 1:5000 means the
maximum scale for theme display will be 1:4999. The Mineral Resources and Energy Branch would
normally in this case set maximum scale to 1:5001, so that the theme will display at 1:5000.

Hotlink to an image

Avenue Script: Link.PhotoImage

Function: A hotlink to images that brings up the image in a view window that is sized relative to
the image size. This gets around the problem of the standard image hotlink in which the image
window must be resized. When the view is dismissed it does not remain in the project.

Use: The script is used in the same way as a normal hotlink script. That is, it must be setup in the
Theme Properties dialogue box.

Hotlink to Autodesk Animation Player (AAPlay)

Avenue Script: Link.AAPlay

Function: hotlinks to AAPlay animation software

Use: As normal hotlink.
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Display scales chosen for cigis themes

Scale

Theme(s) Minimum Maximum
AUSLIG 1:25000 infrastructure 1:10000 1:30001
AUSLIG 1:25000 (other) 1:10000 1:125001
CIA 1:1000 height labels 1:1 1:2001
CIA 1:1000 contours 1:1 1:3001
CIA 1:1000 (other) 1:1 1:10000
Stockpiles (all sources) and in situ 1:1 1:50001
Orthophotographs 1:1 1:5001
DEMs and DEM-derived contours 1:500 1:20001
C-Series' old maps 1:1000 1:10001
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CD-ROM ARCHIVE

Version 1 of the CIGIS is archived on 14 CD-ROMs as shown in Table 1.  There is a key map on
the back of each CD-ROM showing the tiles that are on the CD-ROM.

Table 1 : CIGIS Version 1 CD-ROM Archive
No. CD-ROM Description Files

1 Core data All multi-thematic data (points, vectors, images etc) and some
key enhanced orthophotography.

*.shp, *.tif
&  others

2 Mining enhanced
(8 bit)

Orthophotography with colours and contrast consistently
enhanced for cleared, developed and mined areas   for use in
the CIGIS.

nnnnenmp.tif

3 Western region (8 bit) 256 colour orthophotography with original scanned colours
   for use in the CIGIS.

nnnnpal.tif

4 Southern region (8 bit) ″ ″
5 Northern region (8 bit) ″ ″
6 NW Point (24 bit) Original 16 million colour orthophotography   for image

processing use.
nnnn.tif

7 SW Point (24 bit) ″ ″
8 Central - north (24 bit) ″ ″
9 Central - south(24 bit) ″ ″

10 Township (24 bit) ″ ″
11 SW of township (24 bit) ″ ″
12 East coast - south (24 bit) ″ ″
13 South Point (24 bit) ″ ″
14 Airport region (24 bit) Original 16 million colour orthophotography and all of the

original digital elevation models1.
nnnn.tif
dnnnn.bil

Table 1. Table of CD-ROM contents.

Atlas of orthophotography tiles

The 157 orthophotography tiles are printed on the following nine pages.  Each map of about
eighteen tiles corresponds to a CD-ROM from the 24 bit orthophotography archive held by both
BRS and Territories Office. This set of nine CD-ROMs is for image processing use.  The 24 bit tiles
will work in the CIGIS but take up three times as much disk space as the 8 bit imagery and look no
different. 24 bit orthophotography file names consist a four digit tile number followed by ‘.tif’.   The
8 bit orthophotography file names consist a four digit tile number followed by ‘pal.tif’(‘pal’ for
paletted) or by ‘enmp.tif’ (‘enmp’ for enhanced mining paletted).

                                                
1  The format for these DEM files is 16 bit integer, binary interleave files (‘.bil’) with heights as centimetres and with an

associated ascii ‘world’ file. The remaining available space on the final CD-ROM of both the 8 bit (No 5) and
24 bit (no 14) orthophotography sets is ‘filled’ with miscellaneous CIGIS ancillary files.
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Fig. 33. NW Point   24 bit orthophotography CD-ROM No. 6
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Fig. 34. SW Point   24 bit orthophotography CD-ROM No. 7
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Fig. 35. Central - north   24 bit orthophotography CD-ROM No. 8
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Fig. 36. Central - south   24 bit orthophotography CD-ROM No. 9
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Fig. 37. Township   24 bit orthophotography CD-ROM No. 10
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Fig. 38. SW of township   24 bit orthophotography CD-ROM No. 11



Christmas Island Geographic Information System (CIGIS) Phase 2

14/08/00 3:51 A8/P8    g:\cigis\ci_working\manual\sysdoclr.doc System Documentation 59

Fig. 39. East coast - south   24 bit orthophotography CD-ROM No. 12
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Fig. 40. South Point   24 bit orthophotography CD-ROM No. 13
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Fig. 41. Airport region   24 bit orthophotography CD-ROM No. 14
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Fig. 42. An example use of the CIGIS orthophotography.
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APPENDIX 1 data conversions:
This appendix presents detail on the processes applied in converting data from it’s source form into
the CIGIS.  In each case the source files are stored on the core data CD in the ‘source’ subdirectory.

‘ANCA’ Data

Original ANCA data was obtained from a hard disk of a PC in the Abbott’s Booby Bird office on
Christmas Island. Various Autocad® maps and a DBF file (‘history.dbf’) were used in the CIGIS in
modified form.

Autocad maps

Selection of data

The following Autocad maps were chosen for conversion:
coast line/

peg
ABB
sites

clear
areas

mine
leases

rare
veg

UTM
grid

jab2000.dwg ∇ X ∇ ∇
abbsite.dwg ∇ ∇       ∇
nelson.dwg ∇ X ∇
jvegc.dwg ∇ ∇ ∇

∇  = Contains and remains after conversion
X = Does not remain after conversion

The point data in jab2000.dwg and nelson.dwg did not display in ArcView or Arc either
before or after conversion but could be viewed in XTreeGold. The reason for this is unknown.

‘Jab2000.dwg’ was chosen especially for the UTM grid (not true UTM) until it was realised that this
grid was unnecessary for conversion to CIG85, as the other maps (not ‘abbsite.dwg’) were digitally
in the same coordinate system. It was subsequently dropped from the Christmas Island GIS.

‘Abbsite.dwg’ was in a line/peg grid (therefore more difficult to transform) and contained a plan of
the line/peg grid and Abbott’s Booby sites. It was chosen initially for the Abbott’s Booby sites, and
retained, after discovery of the more up-to-date ‘history.dbf’, for the line/peg plan.

‘Nelson.dwg’ was chosen because it contains the clearings also present in abbsite.dwg, and therefore
was essential for transformation of abbsite.dwg.

‘Jvegc.dwg’ contains rare vegetation.
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Method for Conversion of Data

I.  Conversion out of native AutoCad format (DWG)

There were two alternatives considered here:
(1) Converting in AutoCad to DXF drawing interchange format, and
(2) Converting in ArcView 2.1 to shapefiles

The DXF method was considered preferable because fewer steps were involved.
This method involved conversion in AutoCad (PC-Based) using the DXFOUT command,
porting to UNIX via eXceed FTP, conversion in arc (from DXF to arc format) using
dxfarc and final building of points and arcs in arc using the build command
(the clean command for polygons introduces errors). Unfortunately this method did
not transfer all the arcs or points to the coverage.

The shapefile transfer went smoothly. In ArcView 2.1 (earlier versions cannot
display DWG files) Convert To Shapefile in the Themes menu converts each theme
to a shapefile - actually creating three files

eg. The arcs in abbsite.dwg were converted to
abbsline.dbf (ascii)
abbsline.shp (binary)
abbsline.shx (binary).

These files were ported to UNIX (taking care the Ascii/Binary selection was correct).
The arc command shapearc converts the shapefiles (.shp) to arc format

eg. to create an abbsite line coverage called abbsline
shapearc abbsline.shp abbsline.

Following this the coverages were built using the arc build command.

Notable is that annotation is not preserved in a shapefile and that shapearc on polygons results in
loss of attributes. This was a serious problem with the Abbott’s Booby bird sites (identified by
annotation - the DXF method had to be used) until the use of history.dbf for the sites was decided.

II. Transformation of coverages other than ‘abbsite.dwg’

Nelson.dwg, jab2000.dwg and jvegc.dwg were converted from their UTM-based grid to CIG85 by:
1. Derivation of a formula to convert a point’s coordinates in this grid to true UTM,
2. Merging that formula with the formula defining the X-Y shift between UTM and CIG85,
3. Choosing four tics in the Arc/Info versions of these files (any location; in ArcEdit),
4. Using the merged formula to calculate CIG85 coordinates for each tic, and
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5. Transforming the coverage in Arc/Info (see below “Transformation of ‘abbsite.dwg’” for a
detailed description of the transformation method).

III.  Transformation of the ‘abbsite.dwg’

Following Autocad® conversion of ‘abbsite.dwg’ to ‘abbsite.dxf’ and subsequent dxfarc in Arc/Info
to produce ‘abbscov1’ the transformation process went as follows:
1. Selection of four widely spaced points (more points did not appear to improve the result)

common to both map and reference map (abbscov1 and nelsline - the Arc/Info line portion of the
original ‘nelson.dwg’) to use as reference tics for abbscov1 (in this case vertices on clearing
boundaries), recording their coordinates in a table. The coordinates taken from nelsline should
be updated according to the formula derived from transformation of the other coverages, so that
the two sets of coordinates are the original line/peg coordinates and the final CIG85 coordinates.

2. In ArcEdit, choosing edit abbscov1, and editfeature tic, add the locations of these new tics to
abbscov1.

3. In tables reselect those tics which you did not add as common points. Then purge them, thus
deleting the unnecessary tics.

4. Renumber (so that numbers of tic points on both coverages match) in tables or INFO update.
5. Create a new coverage abbscov2 using abbscov1 as the {tic_bnd_cover}
6. In tables or INFO (the manual recommends INFO) update the tic coordinates of abbscov2 using

the coordinate information taken from the reference map (nelsline) in step 1.
7. Transform abbscov1 using the coordinates in abbscov1. This performs a "linear coordinate shift

of all values (Arc/Info user guide)."

The manual suggests then adding links and using adjust to rubber sheet the features in the coverage
even nearer to those in the reference map. Theoretically, however this destroys the integrity of the
data. Practically, also, this resulted in severe distortion of the line/peg grid (clearly unacceptable).

Conversion of History.dbf

History.dbf was converted by:

1. Importing the table in ArcView
2. Displaying it as an event theme
3. converting the event theme to a shapefile
4. Importing into Arc/Info
5. Adding tics and using the same formula derived in conversion of abbsite.dwg to transform the

coverage into CIG85 coordinates, and
6. Converting the coverage back to a shapefile.
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‘CIA’ Data

Conversion macro

A macro such as the following was used to create a version for use in Arc/Info or ArcView:

---------------------------------------------------------------------------------------------------------------
/* Macro awrvegsp.aml
/* Creates a vegetation cover from the original
/* file (awrvegsp.e00)
/* author alucas
/*
&echo &on
kill relief_veg all
import cover awrvegsp relief_veg
/*
joinitem relief_veg.pat relief_veg.xcode relief_veg.pat relief_veg-id relief_veg-id
joinitem relief_veg.aat relief_veg.acode relief_veg.aat relief_veg-id relief_veg-id
/*
tables
select relief_veg.pat
alter dxf-layer
single_Trees
16
C
dxf-layer
items
select relief_veg.aat
alter dxf-layer
boundary
16
C
dxf-layer
items
quit
/*
/* Builds the imported coverages
build relief_veg lines
build relief_veg points
/*
/* Unsplits the line features (removing pseudonodes) for faster display
&stat 9999
arcedit
edit relief_veg
editfeature lines
sel all
unsplit none
quit
yes
yes
/*
/* Creates a spatial index for faster display etc.
index relief_veg
--------------------------------------------------------------------------------------------------------------
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Conversion steps

The steps involved in this are:

1) import the cover;
 
2) join the xcode and acode tables (containing the relevant information about the features on the

coverage) to the point/polygon and arc tables respectively;
 
3) alter the tables as required;
 
4) build the Arc/Info coverages (points, lines and annotation -- polygons do not build in any of the

ausligwa coverages);
 
5) unsplit the line work ( in larger datasets where appropriate -- to speed up drawing); and
 
6) create a spacial index for display speed.

For all datasets except annotation, shapefiles were created, both for consistency and loading speed.
Checks done by us comparing shapefiles and coverages found that shapefiles were not significantly
faster in drawing or calculation (and were in some cases slower), but were significantly quicker
when loading. Since annotation does not convert to a shapefile, it was necessarily left as an Arc
coverage.

Final version

All themes were shapefile-based except annotation. Each one (where legends were complex) had an
associated legend saved (not necessarily the final one?).

National Park Boundaries (1:1000 Scale)

Format of data as supplied

The data originated as CAD data and was supplied in two formats (Arc/Info export and DXF).
MREB imported the Arc/Info export files into Arc/Info, resulting in a line coverage of a range of
cadastre data, including easements, subdivision boundaries, mining leases, national park boundaries
and proposed national park boundaries, identified in an attribute table item ‘STRUCTURE’.
‘NATIONAL PARK’ included only external park boundaries. Internal boundaries such as those
occurring between a national park and a mining lease within the park were not included.
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Method for conversion of data

It was necessary for the national park to be able to stand alone as a national park area (polygon).
Therefore both external and internal boundaries were needed. In ArcEdit, MREB selected those
lines (arcs) where ‘STRUCTURE’ was equal to ‘NATIONAL PARK’ and those where
‘STRUCTURE’ was equal to ‘MINING LEASE’ and wrote these as a new coverage using the PUT
command. Then all mining leases which did not define an internal boundary to a national park were
selected and deleted. BUILD was used to construct polygon topology for the coverage, and finally an
item was added to the polygon attribute table to identify those polygons which were not national
park ie. were created from internal park boundaries (these were selected, then the records
CALCULATEd into the table).

Final version

The form of the data used in the CIGIS is a shapefile. This was created in ArcView after selecting
the polygons which were national park. Thus the final shapefile, ‘natpark.shp’, should contain all the
current national park areas and only national park.

DOLA Survey Control Data

Format of data as supplied

Data was supplied from DOLA as CI.DAT. In CI.DAT three rows of data relate to each survey
control point. The left most columns contain data relating to different map projections used
(WGS84, CIG92, and UTM) each row pertaining to a particular map projection. The right most
columns are not row-dependent and contain general control point data, height data (Christmas Island
Height Datum (CIHD)) and error data. Each A4 page began with a header section.

Method for Conversion of Data

Supplied Data was opened on Microsoft Excel and saved as doladata.xls and the following steps
were taken to form a database favourable for use in the CIGIS

Expansion of Data

The steps to data expansion were as follows:
•  copying of the station codes (using a macro) so that every row had an associated station

code and database number
•  sorting of the data by projection
•  separation by projection type into three separate worksheets
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•  sorting of the rows of each projection worksheet by station code
•  joining these worksheets into one final with each row having a unique station code and

all its associated data.
•  removal of duplicate columns.

Removal of pagewise header lines

The header section was deleted from all but the first page. On the first page the header section was
simplified to column headings and made unique for all columns.

Addition of CIG85 data

Columns were added to contain the eastings and northings of CIG85. These were filled from data
obtained from AUSLIG, Perth as ‘CHRISTMAS ISLAND CONTROL PLAN CON-2’ (W.A.
Regional Office Plan A2-38I)2. MREB scanned this plan using Optical Character Recognition
(OCR) as an MS Excel worksheet. After checking the data for scanning errors the survey control
I.D.s were matched with those in the original DOLA data (CI.DAT sourced).

The file was exported using File Save As in MS Excel. It was exported in CSV format (Comma
delimited). This format preserved the correct data. Attempts were made to export the data in various
DBF formats, as this is a more useful format to view, but all failed to preserve significant digits. The
CSV version of the data was, for ease of use in ArcView, renamed doladata.txt (ArcView doesn't
recognise the extension .csv). The table was added to an ArcView project and ‘Add Event Theme’
used to display the CIG85 coordinates of the data.  The shapefile attribute table was joined by
station-ID to the CIG92 data attribute table, resulting in a final shapefile containing all points with
valid data for both CIG85 and CIG92. In addition to this, another shapefile (‘92contrl.shp’) contains
all survey control points with CIG92 coordinates. This is in CIG92 projection and therefore not used
in the GIS, but is stored in the ‘DOLA’ directory for future use / reference.

Final format of data

Finally, the theme was then converted to a shapefile for consistency and speed of access. The name
of the final CIG85 shapefile is ‘85contrl.shp’.

                                                
2 An earlier approach was later found to be erroneous. It gave points that were out by about 17 metres, probably due to
CIG85 being based on the geoid WGS72 and CIG92 being based on the geoid WGS84. This initial approach
erroneously calculated CIG85 from an x-y shift on the UTM value (supplied by DOLA) as follows:

x(UTM) - 550000 = x(CIG85)
y(UTM) - 8780000 = y(CIG85)

CIG85 values have since been replaced by the measured eastings and nothings supplied by Auslig WA division as
detailed above.
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FIG 43. Comparison of a colour drape and the orthophotography over the western mining area
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APPENDIX 2 code listings:
This appendix lists some of the ArcView ® Avenue® language code scripts added by MREB to the
CIGIS for specific requirements needed in the system.

View.TileInfo

Author: A. Lucas (based on script by R. Gallagher)

'
'  This script shows DEM, DEM contour and orthophotography tile numbers for CIGIS
'        Written by A. Lucas, MREB, BRS
'           From a script by R. Gallagher
'

theView = av.GetActiveDoc
p = theView.GetDisplay.ReturnUserPoint
'
' x1, y1 refer to orthophotograph tiles
' x2, y2 refer to DEM tiles
' x3, y3 refer to DEM contour tiles
'    DEM contour tile layout not finalised
'    so this result may not be accurate
'
' Calculate the first and second pair of numbers for each identifying tile
' number. This is based on the coordinates of the top left corner of the
' tile.
'
x1=(p.GetX/1000).Floor
y1=(p.GetY/1000).Ceiling
x2=((p.GetX/2000).Floor)*2
y2=(((p.GetY-1000)/2000).Ceiling)*2+1
x3=x2
y3=y2
'
' Account for 4 x 4 kilometre DEM tile in NE corner of island
'
if ((x2>=24) and (y2>=67)) then
  x2=24
  y2=69
end
'
' Add a preceding zero to single digit numbers
'
if (x1<=9) then
  x1="0"+x1.AsString
end
if (x2<=9) then
  x2="0"+x2.AsString
end
if (x3<=9) then
  x3="0"+x3.AsString
end
'
' Display the tile numbers on the status bar
'



Christmas Island Geographic Information System (CIGIS) Phase 2

14/08/00 3:51 A8/P8    g:\cigis\ci_working\manual\sysdoclr.doc System Documentation 73

av.ShowMsg("Orthophoto:"++x1.asString+y1.asString+"             DEM Tile:"++x2.asString+y2.asString+"             DEM
Contour Tile:"++x3.asString+y3.asString)

Text file version: $cigis\etc\tileinfo.ave

---------------------------------------------------------------------------------------------------------------

Project.SetEnvVar

Author: A. Lucas, MREB
'
'Script: Project.SetEnvVar (setcigis.ave)
'Script sets the environment variable $cigis
'
'Get user input
'
dataLoc=MsgBox.Input("Christmas Island Geographic Information"+NL+
"System (CIGIS) directory          eg. C:\CIGIS","Data Location","")
'
'If OK is pressed, check whether the directory
'exists. If it does, set the variable; otherwise
'inform of error
'
if (dataLoc <> NIL) then
  if (not(file.exists(dataLoc.AsFileName))) then
    System.Beep
    MsgBox.Error("ENVIRONMENT VARIABLE NOT RESET."+NL+
    "The directory"++dataLoc.AsString++"does not exist","DATA LOCATION ERROR")
  else
    MsgBox.Info(dataLoc,"DATA LOCATION")
    System.SetEnvVar("CIGIS", dataLoc)
  end
else
end

Text file version: $cigis\etc\setcigis.ave

---------------------------------------------------------------------------------------------------------------

View.CalculateAreaPerimLength

Author: ESRI

' CalculateAreaPerimeterLength
'
' Get the view and its projection if any.
'
theView = av.GetActiveDoc
thePrj = theView.GetProjection
if (thePrj.IsNil) then
  hasPrj = false
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else
  hasPrj = true
end

'
' Get the list of active themes. if there aren't any, let the user know
' and exit.
'
theActivethemeList = theView.GetActivethemes
if (theActivethemeList.Count = 0) then
  MsgBox.Error("No active themes.","")
  Exit
end

'
' Loop through the list of active themes. if you can't edit the theme
' inform the user.
'
For Each thetheme in theActivethemeList
  theFTab = thetheme.GetFTab
  if (theFTab.CanEdit.Not) then
    MsgBox.Info("Cannot edit table for theme:"++thetheme.AsString,"")

    Continue
  end
  '
  ' Make the FTAB editable, and find out which type of feature it is.
  '
  theFTab.SetEditable(TRUE)
  theType = theFTab.FindField("shape").GetType
  if (theType = #FIELD_SHAPEPOLY) then
    '
    ' if it's polygonal check for the existence of the fields "Area" and
    ' Perimeter. if they do not exist, create them.
    '
    if (theFTab.FindField("Area") = nil) then
      theAreaField = Field.Make("Area",#FIELD_DOUBLE,16,3)
      theFTab.AddFields({theAreaField})
    else
      ok = MsgBox.YesNo("Update Area?", "Calculate", true)
      if (ok.Not) then
        continue
      end

      theAreaField = theFTab.FindField("Area")
    end

    if (theFTab.FindField("Perimeter") = nil) then
      thePerimeterField = Field.Make("Perimeter",#FIELD_DOUBLE,16,3)
      theFTab.AddFields({thePerimeterField})
    else
      ok = MsgBox.YesNo("Update Perimeter?", "Calculate", true)
      if (ok.Not) then
        continue
      end

      thePerimeterField = theFTab.FindField("Perimeter")
    end
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    '
    ' Loop through the FTAB and find the projected area and perimeter of each
    ' shape and set the field values appropriately.
    '
    theShape = theFTab.ReturnValue(theFTab.FindField("shape"),0)
    For Each rec in theFTab
      theFTab.QueryShape(rec,thePrj,theShape)

      theArea = theShape.ReturnArea
      thePerimeter = theShape.ReturnLength

      theFTab.SetValue(theAreaField,rec,theArea)
      theFTab.SetValue(thePerimeterField,rec,thePerimeter)
    end

  elseif (theType = #FIELD_SHAPELINE) then
    '
    ' if the data source is linear, check for the existence of the
    ' field "Length". if it doesn't exist, create it.
    '
    if (theFTab.FindField("Length") = nil) then
      theLengthField = Field.Make("Length",#FIELD_DOUBLE,16,3)
      theFTab.AddFields({theLengthField})

    else
      ok = MsgBox.YesNo("Update Length?", "Calculate", true)

      if (ok.Not) then
        continue
      end

      theLengthField = theFTab.FindField("Length")
    end

    '
    ' Loop through the FTAB and find the projected length of each shape and set
    ' the field values appropriately.
    '
    theShape = theFTab.ReturnValue(theFTab.FindField("shape"),0)
    For Each rec in theFTab
      theFTab.QueryShape(rec,thePrj,theShape)

      theLength = theShape.ReturnLength

      theFTab.SetValue(theLengthField,rec,theLength)
    end

  end

  theFTab.SetEditable(FALSE)
end

Text file version: None. This is an ESRI script supplied in the Avenue Script Library.
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View.SetThresholds

Author: A. Lucas, MREB

' SetThemeThresholds

'
' Get the view and its projection if any.
'
theView = av.GetActiveDoc
thePrj = theView.GetProjection
if (thePrj.IsNil) then
  hasPrj = false
else
  hasPrj = true
end

'
' Get the list of active themes. if there aren't any, let the user know
' and exit.
'
theActivethemeList = theView.GetActivethemes
if (theActivethemeList.Count = 0) then
  MsgBox.Error("No active themes.","")
  Exit
end
'
'Query the user for minimum and maximum thresholds.
'
scaleList = MsgBox.MultiInput("Display at:","Set Thresholds for Active Theme(s)",{"Minimum scale
1:","Maximum scale       1:"},{"1",theView.ReturnScale.AsString})
if (not(scaleList.IsEmpty)) then
minScale = scaleList.Get(0)
maxScale = scaleList.Get(1)
'
'Check scale is not set to zero
'
if ((minScale="0") or (maxScale="0"))
then MsgBox.Error("Scale must not be set as 1:0","")
else
'
' Loop through the list of active themes, setting the maximum
' and minimum thresholds.
'
theThreshold = Threshold.Make
For Each thetheme in theActivethemeList
  theThreshold.SetMinimum(minScale.AsNumber)
  theThreshold.SetMinimumOn(true)
  theThreshold.SetMaximum(maxScale.AsNumber)
  theThreshold.SetMaximumOn(true)
  thetheme.SetThreshold(theThreshold)
end
end
else
end

Text file version: $cigis\etc\mxminscl.ave
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Link.PhotoImage

Author: R. Gallagher, for MREB

' Link.PhotoImage

theTif = SELF
if (Not (theTif.IsNull)) then
  theVal="$CIGIS/sitepics/"+theTif
  if (File.Exists(theVal.AsFileName)) then
    srcImage = SrcName.Make(theVal)
    t = Theme.Make(srcImage)
    t.SetVisible(TRUE)

    v = View.Make
    isource=isrc.Make(srcImage)
    v.AddTheme(t)
    v.SetTOCWidth(0)
    v.SetTOCUnresizable(TRUE)
    v.SetName(theVal.AsFileName.GetBaseName)

    if (av.FindScript("View.CloseImageView") = NIL) then
      s = Script.Make("av.GetProject.RemoveDoc(SELF)")
      s.SetName("View.CloseImageView")
      av.GetProject.AddScript(s)

    end

    v.SetCloseScript("View.CloseImageView")

    '' If you've created a special GUI for this document,
    '' activate here using something like the following...
    ' v.SetGUI("aNewGUIName")
    ' av.FindGUI(v.GetGUI).Activate

    v.GetWin.MoveTo(1,1)

    v.GetWin.Open
    if (isource.GetNumColumns > isource.GetNumRows) then
      v.getWin.Resize(isource.GetNumColumns,isource.GetNumRows*1.1)
    else
      v.getWin.Resize(isource.GetNumColumns*1.1,isource.GetNumRows)
    end
    v.GetDisplay.ZoomToRect(t.GetExtent)
  else
    MsgBox.Warning("File "+theVal+" not found.","Hot Link")
  end
end
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Link.AAPlay

Author: A. Lucas, MREB (from a script by R. Gallagher)

'
'Script for hotlink to freeware AAPlay animation software
'
theFile=SELF
'
'Get the environment variable defining the data source
'
theCIGIS=System.GetEnvVar("cigis")
'
'Define the software path
'
theSoftware="\UTIL\AAPLAY\AAWIN.EXE"
'
'Define the file path
'
thePath="\sitepics\animatns\"
'
'If the animation file exists, run it in AAPlay
'
if (not(theFile.IsNull)) then
  System.Execute(theCIGIS+theSoftware++theCIGIS+thePath+theFile)
else
end
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FIG 44. Comparing one meter contours, the orthophotography and a colour drape for the same area
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Appendix 3
This appendix documents the method used by MREB for clipping the DEM in ERMapper® for
secondary mining analysis.

Method For Cropping DEMs and Orthophotos in ERMapper 5.1

1. Open ERMapper by typing “ERM” at the unix prompt (in henric or baldric)
2. Open the appropriate Algorithm3

3. Open the Algorithm window and turn on the bands you want showing
•  Select the relevant orthophoto(s) and the Arc/Info layer, Choose Red/green/blue from the

Colour Mode list and press GO
•  Zoom to the desired region. If it is necessary to zoom out again simply choose View →

Quick Zoom →Zoom to all datasets or another desired zoom setting.
•  Resize the view window so as to minimise null values (hatched areas beyond the image

extents). To ensure no null values choose View → Quick Zoom →Zoom to window extents4

4. Save the algorithm as (stk5p.alg or matching format − stk indicates the cutout is around a
stockpile, 5p is the correct stockpile label − please use 8.3 naming convention)
•  Choose File → Save As

5. Save the cut out orthophoto portion as a dataset
•  Turn off the Arc/Info layer in the Algorithm window (ensuring that only the orthophoto is

turned on) and press GO
•  Save the algorithm as a dataset. Choose File → Save as dataset (or press the Save algorithm

as dataset button). Name the dataset as per the convention previously outlined (eg.
stk5p.ers). Be sure to choose defaults in this window (setting size and type of the dataset).

6. Save the cut out DEM portion as a dataset
•  Turn on the DEM (pseudocolor) layer and turn off all other layers, choose Pseudocolor as

the Colour Mode and press GO
•  Open the Transform window
•  From the Limits drop-down menu choose Set Limits to Actual (press GO if you wish to see

the DEM as a pseudocolor image) then choose Set Output Limits to Input Limits and press
GO.

•  Save the algorithm as a dataset. Choose File → Save as dataset (or press the Save algorithm
as dataset button). Put a “d” first in the filename to indicate it is the DEM (eg. dstk5p.ers).
Be sure to choose defaults in this window (setting size and type of the dataset).

7. Export the DEM as an ASCII
•  Under Utilities choose Export raster format → ASCII XYZ → Export (name should be

dstk5p.xyz or the like)
•  Also export an ascii Z format file Utilities → Export Raster format → ASCII BIL → Export

(named dstk5p.z or the like)

                                                

3 Choose File Open (or the Open button) and use the Directories menu to navigate to
/mrbgis/workspace/ermapper then navigate to the algorithm you wish to use (for the DEM in the NE
corner of the island choose /mrbgis/workspace/ermapper/bhptiles/d2469_4k.alg).
4 DO NOT adjust the window after this step.


